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There’s more to the Sheet Set Manager than the Sheet
Adam Reilly
M&S Engineering

Learning Objectives
•
•
•
•

Identify the different parts of the Sheet Set Manager.
Create custom data fields to store reusable reference data.
Create a library of drawings that can be easily added and labeled on a sheet.
Create custom labels that reference information in other sheets or sheet sets.

Description
In this class, we will get in-depth with the Sheet Set Manager to discuss and create Sheets and
Sheet Sets. We will learn about custom properties and how to use them to store huge amounts
of reusable data. We will discuss and learn about Sheet Views and how to use them to make
adding our design details to the plans a breeze. We will discuss how the Sheet Set Manager
can be used as a lightweight project explorer to navigate all our projects’ design files. We will
discuss and learn about labeling our sheets and sheet views. We will learn how to create blocks
with predefined attributes that will fill in data from the sheet set automatically. We will learn how
to quickly plot or publish individual or multiple sheets with minimal clicks. Lastly, we will learn
how to organize our sheets with subsets or with selection sets to track additional stages in the
design or construction processes.

Speaker
Adam Reilly has worked in the Civil Engineering field for nearly 20 years and has been a user
and champion for Civil 3D since his introduction to the software in 2006. Throughout his career,
he has successfully implemented standards and workflows for Civil 3D for three firms in Texas
and currently works as a CAD Manager for M&S Engineering, where he is responsible for the
maintenance and development of standards, workflows and processes for multiple offices. He
still regularly wears his designer hat as well, which keeps him well grounded in the day-to-day
needs of his users.
Mr. Reilly is an Autodesk Civil 3D Certified Professional who is passionate about CAD. He coleads the Austin CADD User Group, where he regularly teaches Civil 3D topics.
When he is not tinkering and writing customizations for Civil 3D, Mr. Reilly can be found tending
his garden, if the heat isn’t unbearable.
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What is a Sheet Set?
Introduced with AutoCAD 2005, a Sheet Set is, at it’s core, a simple database and is saved as a
*.dst file. The database stores and organizes links to paper space layouts of drawing files
(known as Sheets), saved views on those sheets (known as Sheet Views), and stores typical
project and custom data that can be reused across the sheet set or on a per sheet basis.

File types used by the Sheet Set Manager

Other file types to be aware of
The *.ds$ is a backup file created and updated when you open the original *.dst file.
The *.dbl is a lock file, which tells AutoCAD who has the *.dst file locked for editing.

What is the Sheet Set Manager?
The Sheet Set Manager is the mechanism, or interface, that you can access and manipulate the
data and sheets in your project. The Sheet Set Manager is accessed from the View tab of the
AutoCAD ribbon or the Home tab of the Civil 3D ribbon.

The Sheet Set Manager can be found on the
View tab of the AutoCAD ribbon.

The Sheet Set Manager can also be found
on the Home tab of the Civil 3D ribbon.

Alternatively, you can enter ‘SSM’ at the command line.
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Identify the parts of the Sheet Set Manager
Sheet List tab

Anatomy of the Sheet List tab

When opening the Sheet Set Manager, the Sheet List tab is the default view. From here, you
can see all the Sheets and Subsets in your Set. You also have several Sheet commands
available. At the top of the window, you have the Sheet Set Selector, which lists all open Sheet
Sets and lets you switch between them. You can select from up to ten recently opened Sheet
Sets. You can also create a new Sheet Set or open an existing one.
To the right of the selector you have an Export button, which will export the entire Sheet Set to
the selected file type. By default, this file type is DWF. You can click the down-arrow to the right
and change the file type to DWFx and PDF.
Next you have the Publish button. Clicking this button will present a menu of many ways to
publish your Sheets. You can also find this menu by right-clicking any item in the Sheet Set list
and traversing the menu to the Publish sub-menu item.
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The publish menu

As you can see in the image above, there are a host of publishing options with the Sheet Set
Manager. The top four options (publish to DWF/DWFx/PDF/Plotter) all initiate a plot of the last
saved layout setup of the selected Sheet(s). For example, if your Sheet is supposed to be a
30”x42” sheet, but someone changed the page setup to be a 12”x18” sheet to manually publish
just a section of the page and then saved that file, that 12”x18” area would be the output by
default. If this is a common occurrence, or you want to ensure you publish your sheets with a
specific layout, you can define Page Setup Overrides.
Page Setup Overrides are a series of page setups created in a single file. You set the Sheet
Set’s Page Setup Overrides value to the file containing these layouts and when publishing,
select the Override you would prefer to use.

Page Setup Overrides applied to the current Sheet Set
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If a Sheet is selected when you click the Publish button, an Include for Publish option will be
added to the menu. If you select No, the Sheet(s) selected will be tagged accordingly and any
publishing commands that include the Sheet(s) will explicitly exclude them. You will have to
mark them to be Included again, if you want to publish them through the Sheet Set Manager.
The Edit Subset and Sheet Publish Settings option gives you a more visible indication of what
Sheets or Subsets have been marked to Include for Publish. If you select the Edit Subset and
Sheet Publish Settings, a dialog showing all the Sheets and Subsets will be displayed with
checkboxes. Checked items will be included for plotting.
The next two options are on/off options for controlling the direction of publishing, which is done
from top to bottom, by default, and including a plot stamp. Publishing in Reverse Order can be
very useful if you have two people publish a set of plans and want to have them ‘meet in the
middle’. The Plot Stamp Settings dialog opens the Plot Stamp dialog box.
The Manage Page Setups option allows you to create new Page Setups specific to the current
Sheet Set. The Sheet Set DWF or PDF Publish Options both provide specific options for where
the files created will be stored and at what quality. The default publishing location will be your
Documents folder, but it can also be set in the Sheet Set template if you would prefer a more
centralized location.
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DWF publishing options
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PDF publishing options

The final publishing option is the Publish Dialog Box… This dialog box gives you a uniform
location to access most of the previous options. You can even use the dialog box to publish
Sheets from files that are not part of your Sheet Set. At the top left, you can select a specific
Sheet List, which is created as a separate Sheet Description File, with a *.dsd extension. You
can select the output type, which are the default settings of the page setup, a PDF, DWF or
DWFx. When changing the Publish To option, the Publish Options to the right will change to
allow changes where applicable. The Sheet Set Publish Options button (grayed out in the image
below) will show either of the above two dialog boxes, depending on the Publish To selection.
The power of this dialog box for publishing can best be seen in the middle section, where you
can add or remove Sheets, reoder the Sheets and even change the Page Setup of each Sheet.
If you wanted to, you could specify multiple page sizes or output mediums in a single publish
command. The section at the bottom gives you detailed information about the selected Sheet
with a few more options for how to publish.
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The Publish dialog box

The final button along the top is the Sheet Selections button. From here, you can create and
manage (rename and delete) Sheet Selection Sets. These selection sets will be stored with the
Sheet Set and can be used to recall a selected group of sheets.
Typical uses for this tool could be tracking revisions or storing sheets most frequently opened or
published.
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Sheet Views tab
The second tab on the Sheet Set Manager lists any/all views that have been placed on a sheet.

Anatomy of the Sheet Views tab

The Sheet Views tab has fewer options and is often over looked because it is only populated
with data when you add a view to a Sheet in the Set. At the top of the window, you have the
familiar Sheet Set Selector, with the same options as the Sheet List tab. You also have a New
View Category button, which will be grayed out by default. Directly below that are two buttons,
the Sort by Sheets and Sort by Category buttons allow you to change the look of the Sheet
Views list. In the image above, the list is sorted by sheet. If you select Sort by Category, it will
change the list to group each view by the categories they were added to.

The same Sheet Views list, sorted by Category.

When sorting by Category, the New View Category button is enabled.
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There are not many options you can do on this tab. You can right-click on the Sheet Set to
access its properties, just as you can do from the Sheet List. You can right-click a Sheet (if
viewing the sheets) and open the Sheet drawing.
You may also right-click the View for the most options.

Right-click options for Sheet Views

The Display option will allow you to open the drawing containing the view and zoom directly to it.
You can also rename and renumber the views, which works very much like the rename and
renumbering of Sheets. You can change the category of the view and you can also add a
Callout or View Label block.
A Callout block is generally used elsewhere in your set and tags an object or location with a
label that refers to the View on it’s Sheet. The View Label is the block used to callout the
number, name and scale of the View. In this way, you can see how Views would be an
important and easy way to annotate details in your plan set.
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Model Views tab

Anatomy of the Model Views tab

The Model Views tab can be a little more mysterious. When you first create your Sheet Set, it
has no information and the Add New Location… option doesn’t really tell you much.
Personally, I find this to be a very useful panel – I spend more time here than I do in the Sheet
List during a project.
The Model Views tab is very simple, with the same Sheet Set Selector at the top, a Refresh
button and an Add New Location button. This button does the same as the Add New
Locations… line below it. You can double click the line under the Locations panel, or click the
button in the upper right and you will be presented with a folder selection dialog. If you select a
folder location, the Model Views tab will list all the drawings in the selected folder.
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The Model Views tab with a location added

Once you’ve added a location, you can now see all the drawings and subfolders in the folder. In
the image above, I selected the root folder for my projects drawing data and can see the folder
for my base files, sheet files and details. If you drill down to the lowest level the Model Views tab
allows, you can see the model space views saved inside of each individual drawing.
If you right-click a view, you get two options: Open and Place on Sheet. This is the primary
mechanism to be able to add Views to your Sheet!
If you right-click on a file, you get a few extra options, too.

Right-click a file in the Model Views tab

You can open the file (for edit or read-only), place the entire drawing on a sheet, expand thet
tree view to see the Views and eTransmit.
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If you open a file from the Model Views tab, keep the name in mind. It will always take you to the
Model space of the drawing you open. If you open a view in a drawing, it will take you directly to
that view as well.
When you hover your cursor over any item in any tab of the Sheet Set Manager, it will present
you some extra data about the file or view as well as a preview image. You can modify this
tooltip data to change the image size or the data shown by right-clicking anywhere in the
window that is not a Sheet, View or file, as shown below.

Right-click to change the tooltip options

You can also select the Preview/Details Pane option in order to see that information at the
bottom of the window. At the top-right of the Details Pane, are two buttons to switch between
the Preview and Details options. Once the Details Pane is turned on in any tab, it will be on for
all tabs.

The Model Views tab with the Preview/Details Pane on
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Sheet Set Properties
To access the Sheet Set Properties, from either the Sheet List or Sheet Views tab, you can
right-click on the Sheet Set’s name and select the Properties… option at the bottom of the
menu.

Right click menu on the Sheet List tab

Anatomy of the Sheet Set Properties dialog box

Most of the settings and data stored with the Sheet Set can be accessed through the Sheet Set
Properties. When you first create a new Sheet Set, you can set most of the data but, quite often,
you may need to make changes to the Sheet Set. From the Sheet Set Properties, you can
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change the Sheet Set Name, which is the text shown at the top of the Sheet List or Sheet Views
tab and is not the same as the file name. You can edit the description, add or remove the Model
View locations, edit the Label and Callout blocks and degine the Page Setup Overrides file from
the top section of the Sheet Set Properties. The Project Control section of the Properties was
added to the Sheet Set Manager in version 1.1, released with AutoCAD 2006. These additional
properties are typically used for tracking Project Number, Name, Phase and Milestone.
Sheet Creation properties are also modified here. You can set the default location of all Sheets
in the Set with the Sheet Storage Location. The Sheet Creation Template allows you to set
which template file and layout are used for all new Sheets. You may even set a prompt for a
template when creating a new Sheet. This would primarily be used if you have a series of Sheet
Templates that you want to use, instead of changing the template before each Sheet, you just
select the template.
Custom Properties are created and edited from the Sheet Set Properties, which are covered in
more depth, beginning on page 18.

Subset Properties
Just as the Sheet Set has properties, each Subset has it’s own set of properties that you can
edit. By right-clicking on any Subset in the Sheet List, you can select the Properties… option at
the bottom of the right-click menu.
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Anatomy of the Subset Properties dialog box

A Subset has only a small number of settings that can be changed. You can change the name,
control if the entire Subset is published during publishing operations and where new Sheets are
stored. You can also change the template used by the Subset or have the user be prompted for
a template with each new Sheet.

Page 16

Sheet Properties
Additionally each Sheet has it’s own set of properties that you can edit. By right-clicking on any
Sheet in the Sheet List, you can select the Properties… option at the bottom of the right-click
menu.

Anatomy of the Sheet Properties dialog box

In the Sheet Properties, you can edit the Sheet title, number and description, change the include
for publish setting and even change the layout and file the Sheet is associated to. Be aware,
you can not select a drawing layout that is already part of another Sheet Set. If the Sheet has
any custom properties, they will be listed below the Sheet section.
At the bottom of the dialog box, you will see several options for renaming the layout or drawing
file. These options are reflected on the Rename and Renumber dialog box as well. They allow
you to change the layout tab name or the drawing file name, based on the Sheet title and
number. The drawing file renaming options will be disabled if you have the file open. All of the
renaming options will be disabled if the file is open by someone else.
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Create Custom Data Fields
Custom Properties are possibly one of the most powerful features of the Sheet Set Manager,
and yet very simple to use. Custom Properties come in two flavors: Sheet and Sheet Set.

•
•

Sheet Set owned properties are ‘global’ to the Sheet Set and can store data that is only
entered or edited once, through the Sheet Set properties.
Sheet owned properties are Sheet specific. Once you create a Sheet property, it is
assigned to each Sheet in the Set with a default value and the value can be edited from
the Sheet properties at any time after that.

Creating a new Custom Property
To create a new Custom Property, follow these steps:
• From the Sheet Set Manager, right click the current Sheet Set name, at the top of the
Sheet List or Sheet Views tab.
• Select the Properties option, at the bottom of the menu.
• Click the Edit Custom Properties… button on the bottom left of the Sheet Set Properties
dialog box.
• Click the Add… button on the Custom Properties dialog box.
• Enter a Name and Default value for your Custom Property.
• Choose the ownership (Sheet Set or Sheet).
• Click OK.
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Right click menu on the Sheet List tab

Click here on the Sheet Set Properties dialog box

The Custom Properties dialog box
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The Add Custom Property dialog box

About Custom Properties
Ideally, if you have a piece of data that is input more than once in a set of plans, it should be a
Custom Property. As a Custom Property, you only have to edit it once and it propagates to all
locations. But, be mindful - Custom Properties are stored as text values, so if you enter any
numbers, AutoCAD will treat it like text. This is especially important if you want to format data as
numbers in a table. But, you can force AutoCAD to convert the text to a number by inserting the
Custom Property in a formula. There are two ways to accomplish this:
• Using a table object, you can simply use the =[property]/1 forumula, where [property] is a
link back to your Custom Property.
• Any other text object, you can insert a Formula field with the same [property]/1 formula.

Formatting a Custom Property in a Table

Example of a custom property with a number value
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Side by side example of formatting a Custom Property

The formula to convert the text into a number type

Formatting a Custom Property in Text
Select the Objects type of field and the Formula sub-type. In the Formula window, insert
another field that references your Custom Property and divide by 1. Click the Evaluate
button to update the Preview and change the Format.
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Inserting a Custom Property into a text object

With the ability to convert a Custom Property into a number data type, you can then get a little
more complex with your data, such as converting units or doing mathematic functions on your
data.

Creating a drawing library
The primary benefit of the Model Views tab is the ability to insert a saved model view into the
paper space layout of your Sheet file. This becomes an obvious benefit when working with
detailed views of your design or when creating detailing sheets of any kind.
Before you really get started in using your detail library with this method, you will need to
prepare the drawing files by creating saved views of the precise areas you want to be able to
insert. Additionally, if you want to insert them to scale, ensure the view you save is set to the
scale you would prefer.
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Steps to create a new saved view

Once you have your views saved, you can review them in your Model Views tab of the Sheet
Set Manager.

Refresh the Model Views tab to see your new file or view

To insert a view, you need to be in the paper space layout of a Sheet that is part of the active
Sheet Set. If your layout is not part of the Sheet Set you will get a warning dialog, but you will
still be able to add the view. If you add a view before adding the layout to the Sheet Set, you will
not be able to access the data about the view (Number, Name, Scale), as it will have nowhere
to be stored upon creation.
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Right click the view in the drawing you want to insert and select Place on Sheet

Steps to insert your View
•
•
•
•

On the Model Views tab, right click the view in the file
Select Place on Sheet
Optionally, adjust the view scale before placing
Choose the location on the sheet to insert at

If you need to change the scale of the View as you insert it, simply right click and you will
be presented with the list of scales in your current drawing. Be mindful, if your view is
drawn in Imperial and your Sheet is in Metric, you will need to adjust the scale list
beforehand in order to select the scale you might want. The first item in the scale list is
always the Views defined scale, and may even be a scale that does not reside in the
current drawing.

Right click before placing the View in order to change the scale.

When placing the view, AutoCAD will show you a silhouette of the viewport and the view from
the file. Be aware that if your file has a different insertion units set, you may see the view come
in at the wrong scale during the preview. Once you place the view, a new viewport will be
created on the current layer and the file you inserted will have been added as an xref. Again, if
the insertion units differ, there will actually be two copies of the file. One will be the original size
and will have been placed on a layer frozen in the new viewport, the second will have been
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scaled according to the insertion units and placed on it’s own layer which will not be frozen in
the viewport.

Two My Detail File layers were created because the Detail File has an Insertion Units of Inches and the
Sheet is using Feet

To avoid duplicate xrefs and layers, it would be good practice to leave the Insertion Units to
Unitless in your detail file.

Behind the scenes
The View insertion process simplifies many commands into one neat package. AutoCAD
creates a layer specific to the view, so that multiple files could have line work residing in the
same location. A viewport is then created and all other layers are frozen within it, so only the
intended view will be visible. Any other viewports on the sheet will have the new layer frozen
within it, to prevent visibility issues with previously inserted views. The ability to rescale the view
dynamically on insertion makes it much easier to get the correct view clarity necessary. And the
icing on that cake is to have these views accessible for cross referencing from other files.

Create custom labels
With the Sheet Set Manager, there are two types of labels used for your Sheet Views: the Label
View block and the Callout block. The View Label is a block that is used to callout the number,
name and scale of the View, typically placed near the Sheet View. A Callout block is generally
used elsewhere in your set and tags an object or location with a label that refers to the
associated Sheet View.
In both label types, you have three properties you can pull from to use that are specific to that
view. They are: View Title, View Number and Viewport Scale. If you created the view in your
sheet by any method other than inserting it from the Model Views tab, such as creating a saved
view within the paper space of your Sheet, the Viewport Scale will not work.
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The field properties available for Sheet Views

Label View blocks
The Label View block is the most commonly used block with Sheet Views. It is most often the
title block text that is used to label the View on the Sheet.

Label View block showing the View Number, Name and Viewport Scale

Like any other block that you have likely used, this block makes use of attributes. The primary
difference in this case, is the default values of the attributes are pre-populated with Placeholder
values.The Sheet Set Manager has a small number of Placeholder types that can be used as
stand-ins for the real data that may not currently exist at the time you define your block. When
you place a Placeholder in your block and insert the block using the Sheet Set Manager’s
labeling functions, the Placeholder is converted into a link to the applicable data.

The Sheet Set Placeholder types
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The most commonly used Placeholder types for a Label View block are the ViewTitle,
ViewNumber and ViewportScale. Each of these corresponds to the linked data as shown in the
Label View block shown on the previous page.

Callout blocks
A callout block is most useful when you need more detail on your design and need to point the
plan reviewer to another place in the plans. Many times, you might cluster your details in a
series of sheets elsewhere in the plans and it can get very confusing to find if you do not tell the
reviewer where to find them. A Callout block is intended to be used for that purpose. The block
itself can be as complex or simple as you like.

A simple Callout block directing the review to a specific detail on a specific sheet

In the example above, there are two attributes used. The first is prepopulated with the words
“See Detail ” and a Placeholder for the SheetNumber. The second attribute is prepopulated with
“On Sheet “ and the SheetNumber Placeholder. In this way, when selecting the Place Callout
Block command from the Sheet Views tab, the data is appropriately assigned and linked to the
correct View and Sheet. If you need to renumber either the View or Sheet, it will be dynamically
linked.
One caveat to keep in mind, if you need to move your View from one Sheet to another, it will
break any links to the View. This is because you cannot just move the View, you need to insert
the View on to the new Sheet and delete the View from the previous sheet. To delete a view,
you need to open the Sheet and delete the Layout View from the View Manager.
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To delete a View, run the View command in the Sheet and delete the Layout View

Setting the Sheet Set properties for the blocks
The blocks are added to the Sheet Set through the Sheet Set Properties. Right click on the
Sheet Set name in either the Sheet View or Sheet List tab and select Properties, at the bottom
of the menu. Under the Sheet Set header, at the top of the dialog box, are two locations. The
Label block for views option is used to set the Label View block, while the Callout blocks item is
used to set the Callout block locations.
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Adding Callout and Sheet View blocks to the Sheet Set Manager

Note the wording in the dialog box, as it implies a single block for the Label Views and multiple
blocks for the Callout blocks can be set. If you prefer to use more than one Label View block,
you will need to manually change the block as necessary, although common practice is to use
the same block across the plan set. Different Label View blocks are very common, depending
on the way a detail is to be called out. You might have a block for calling out a section, or you
might have a block calling out an area of increased detail. Having a library of blocks makes it
much easier to select the one you want to use as you insert the Callout block.

When placing a Callout block, you have the option of selecting the appropriate block, if it is available
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Bonus content
If you have Civil 3D 2020.1 or Civil 3D 2021, you can use Dynamo for Civil 3D. With Dynamo,
you can create graphical scripts to make your own programs. Dynamo for Civil 3D is still in it’s
infancy, and has limited capacity for Autocad and Civil 3D object data I created the AMR Sheet
Set Manager package in order to automate the Sheet Set Manager tasks.

Using the Online Package Search, type AMR to find it more quickly

The package comes with several sample graphs to demonstrate how to add and edit custom
properties, renumber or rename sheets, and add and delete sheets or subsets.
The samples will be installed to: %AppData%\Roaming\Autodesk\C3D
2021\Dynamo\2.5\packages\AMR Sheet Set Manager\extra
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Example graph showing how to add new Sheets to the Set
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Example showing how to update a Custom Property storing the total count
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